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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor 
for the rights of third parties, which may be effected in any way by the use thereof.  Any representations in this document concerning 
performance of Evertz products are for informational use only and are not warranties of future performance, either express or implied. The only 
warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation 
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Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no 
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or 
order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If 
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make 
changes in equipment design or specifications. 
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1. OVERVIEW  

The 7780DEC-MP2HD is a professional high quality MPEG-2 SD and HD decoder card. It offers high 
end SD and HD decoding of a signal coming from either ASI input or IP. The 7780DEC-MP2HD is 
perfect for monitoring applications or decoding for downstream baseband video and audio processing. 
 
The 7780DEC-MP2HD can reconstruct in the most flexible way all VANC & HANC data in the HD/SDI 
output. The front end of the 7780DEC-MP2HD includes basic ASI or IP input monitor. An optional DVB 
TR101290 type of measurements is available (+MON Option). The 7780DEC-MP2HD offers 2 
swappable ASI inputs. 
 
The 7780DEC-MP2HD can be coupled with Evertz RF front end (7780DM2-LB DVB-S2 demodulator) 
and Evertz downstream video and audio processing equipment to create a complete versatile 
integrated receiver/decoder. 
 
The 7780DEC-MP2HD supports 4:2:0 video decoding but can be upgraded to full HD 4:2:2 video 
decoder. (+4:2:2 option) 
 
Features 

• SD or HD 4:2:0 Video Decoder 
• ASI or IP Input 
• Selection of decoded service 
• (HD) SDI with embedded audio and ancillary data 
• Monitoring of ASI or IP inputs 
• Fully integrated with the industry leading VistaLINK® PRO system 
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Figure 1-1: 7780DEC-MP2HD Block Diagram 
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2. INSTALLATION 

To successfully install the 7780DEC-MP2HD: 
 

1. Unused IP address on the network or a DHCP server. 
2. Evertz serial cable. 
3. VLPro Server IP address. 

 

2.1. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn.  Locate on a 7700 chassis three adjacent vacant 
slots. Unpack the 7780DEC-MP2HD and separate the rear panel from the main card. Locate on the 
rear of the rack the three slots and remove the blanking panels. Insert the rear panel into the back of 
the chassis and secure using the six screws provided.  
 

 
Figure 2-1: 7780DEC-MP2HD 
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Figure 2-2: 7700 Chassis and 7780DEC-MP2HD Rear Panel 

 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7780DEC-MP2HD card into the corresponding front slots ensuring the card lines up with 
the slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that 
when it mates with the rear card that is has been firmly pushed into a seated position. This can be 
confirmed when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables 
to the rear card (failure to do this could cause unwanted network issues) until the initial configuration 
has been completed. 
 

 
Figure 2-3: COM Port Properties Window 
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Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration:  
 

 

 
 

 
 

Click OK to apply these settings and press the return key. The session should respond with the 
7780DEC-MP2HD Main Menu as shown in Figure 2-4:  
 

 
Figure 2-4: HyperTerminal Main Menu 

(1) Network Configuration 
This sub-menu enables the user to configure the network settings for the card. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(3) Setup Decoder Parameters 
This sub-menu is used to configure the decoder parameters. As this configuration can also be 
performed via VLPro this sub-menu will not be covered in this section. 
 
(4) Utilities 
This sub-menu contains two utilities. One command is for clearing the memory, and the other for 
clearing the flash. In normal operation it should not be necessary to use either of these options. 
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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(5) Engineering/Debug 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic 
network settings via the serial cable.  Refer to section 2.2. 
 

2.2. CONFIGURING THE BASIC NETWORK SETTINGS 

Now select option (1) Network Configuration, the Network Configuration menu will be displayed as 
shown in Figure 2-5. If you prefer to use DHCP then you may select option (5) Use DHCP, and then 
continue from step 4: 

1. Select option (1) Set IP Address and configure the IP address for the 7780DEC-MP2HD 
ensuring that the IP address is not already in use on the network.  

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  
3. If required also configure option (3) Set Gateway.  
4. Exit from the Network Configuration menu using (s) Save and Exit, NOT (x) Exit. 

 

 
Figure 2-5: Network Configuration Sub-Menu 

 
From the Main Menu select option (2) SNMP Configuration. Select option (1) Set IP Address and enter 
the IP address of your VLPro Server.  Exit using option (S) Save and Exit, now extract the card from the 
rack, remove the serial cable and re-insert it. 
 
You have now completed the necessary minimum configuration and can connect the cables to the rear 
card when ready. 
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2.3. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7780DEC-MP2HD jar file to the server and both the client and 
server applications have been restarted. If you are the network administrator refer to section 6.2 for 
information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol. 
Your 7780DEC-MP2HD should appear as a newly listed device with the IP address used to configure 
the card in Step 1 above. It may take up to a minute to appear while the card and switch negotiate 
network settings (this can be verified directly on the switch if necessary). 
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Listed below the 7780DEC-MP2HD will be two inputs numbered one and two.  
 

 
Figure 2-6: VistaLINK® PRO Hardware Configuration 

 

 

Note: If after a couple of minutes the card has still not appeared try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain greyed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3. CARD CONFIGURATION 

Right click the IP address of the 7780DEC-MP2HD and select “View Configuration”. The configuration 
page will open; it is from these configuration tabs that the 7780DEC-MP2HD can be configured. Refer 
to the relevant section of this manual for an explanation of the features and functions. 
 
3.1. INPUT SELECT 

The input selection tab is used to select the input in use. Both inputs are bypass protected, thus in the 
event of the card failing, being removed or the power being cut off, the loop-through for the ASI will 
continue. The decoded output will no longer be available. 
 

 
NOTE: If the card is removed from the chassis, the ASI loop through will continue 
but the decoded output will no longer be available. 

 
 

 
Figure 3-1 VistaLINK® PRO – Input Select 

 
• Input Select: The decoder card has two ASI inputs and one IP Input (IP input not currently 

available EXP: Q2 2008). Select here the input you require.  
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NOTE: The decoder has two ASI inputs; the card is a single decoder and is only 
able to decode one program from either of the two inputs. 

 
• Input Mode Select:  

o Input Stream Mode: The Input Stream Mode options available are ATSC, DVB and 
MPEG. It is important to select the standard to which the stream is being coded as this 
affects the context of the alarms for ETSI TR 101 290 priority 3 and the handling of AC3 
Audio.  

 

3.2. PROGRAM TUNING 

 
Figure 3-2 VistaLINK® PRO – Program Tuning 
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3.2.1. Program Tuning 

• Program Tuning Mode: Options are Auto, Program Select or PID Select.  
o Selection of Auto will set the decoder to decode either the first program in the PAT or the 

lowest program number; this can be selected using the next configuration option below.   
o Program select allows the user to define the program number, PCR, video and audio 

selection is automatic based upon the PMT.   
o PID Select allows the user to define the PCR, Video and up to four audio by their PID 

numbers. The PMT PID is ignored. 
 

• Auto Program Select Mode: Options are First Program in PAT or Lowest Program Number. 
o First program indicates the first program defined within the PAT. 
o Lowest program number will select the program with the lowest Program ID. 

 
• Program Number: When the Program Tuning mode is set to Program Select, enter in this field 

the Program ID in decimal form.  
 

 

Note:  You may use the Select Program drop down menu to select the program 
that you wish to tune into.   The drop down menu will be automatically populated 
with the program numbers available in the incoming stream. 

 

 
Figure 3-3: Select Program Drop Down List 

 
• Video PID Number: When the Program Tuning mode is set to PID Select, enter in this field the 

Video PID ID in decimal form. 
 

• PCR PID Number: When the Program Tuning mode is set to PID Select, enter in this field the 
PCR PID ID in decimal form. 

 
• Audio Service 1 PID Number: When the Program Tuning mode is set to PID Select, enter in 

this field the first Audio PID ID in decimal form. 
 

• Audio Service 2 PID Number: When the Program Tuning mode is set to PID Select, enter in 
this field the second Audio PID ID in decimal form. 
 

• Audio Service 3 PID Number: When the Program Tuning mode is set to PID Select, enter in 
this field the third Audio PID ID in decimal form. 
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• Audio Service 4 PID Number: When the Program Tuning mode is set to PID Select, enter in 

this field the forth Audio PID ID in decimal form. 
 

• Video Playout Type:  This field determines the type of video playout. The Playout type options 
are PTS (Presentation Time Stamp) or VBV (Video Buffering Verifier), but default PTS will 
be selected. 

 

 
NOTE: When Program Tuning Mode is set to PID Select, it is possible to select any 
audio from any service with the transport stream.  

 

3.3. PROGRAM INFO 

 
Figure 3-4: VistaLINK® PRO – Program Info 

 

3.3.1. Program Monitor 

• Program Number in TS: The currently decoded Program ID is displayed here in decimal form. 
 

• PMT PID: The currently decoded Program Map Table Packet ID is displayed here in decimal 
form. 

 
• PCR PID: The Program Clock Reference Packet ID is displayed here in decimal form. 

 
• Num Video Streams: The number of video streams within the program is displayed here. 

 
• Num Audio Streams: The number of audio streams within the program is displayed here. 
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3.3.2. Video Monitor 

• Video PID Number: The currently decoded Video Packet ID is displayed here in Decimal form. 
 

• Video Bitrate: The current video bitrate is displayed here; this value will be variable for video 
encoded in VBR. 

 
• Video Resolution: The currently decoded video resolution will be displayed here; this is read 

from the PSIP/PSI. 
 

• Video Profile and Level: The currently decoded video profile will be displayed here; this is read 
from the PSIP/PSI. This will either be MP@ML or MP@HL. 

 
• Video Chroma Format: The currently decoded video resolution will be displayed here; this is 

read from the PSIP/PSI. This will either be 4:2:0 or 4:2:2. 
 

3.3.3. Audio 1/2/3/4 Monitor 

• PID Number: The currently decoded Audio Packet ID is displayed here in Decimal form.  
 

• Bitrate: The current Audio bitrate is displayed here. 
 

• Audio Type: The currently decoded video resolution will be displayed here; this is read from the 
PSIP/PSI.  

 
• Sampling Rate: The currently decoded Audio Sampling rate will be displayed here; this is read 

from the PSIP/PSI. 
 

• Num Channels: The number of channels of Audio in the currently decoded program will be 
displayed here; this is read from the PSIP/PSI. 
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3.4. OUTPUTS 

 
Figure 3-5 VistaLINK® PRO - Outputs 

 

3.4.1. Embedding Audio Source 

• Group 1/2/3/4: The 7780DEC-MP2HD automatically embeds the selected audio streams into 
the outgoing SDI. Here it is possible to re-arrange the audio streams and/or embed other 
separate audio streams. Simply select for each Group, which Audio should be embedded. 

 

3.4.2. Embedding Audio Delay 

• Group 1/2/3/4: The 7780DEC-MP2HD card automatically embeds the selected audio streams 
into the outgoing SDI. It is possible to add an additional delay to synchronize the audio and 
video stream. Simply slide the audio delay to the desired setting for each audio group. The 
maximum delay is 500ms. 
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3.4.3. Misc. Control 

• Output Video Mode: Options are continuous or discontinuous. When in continuous mode and 
the user switches between inputs, the output will not be dropped between sources, the output is 
thus continuous. In discontinuous mode the output, when switching between inputs, will drop 
momentarily. 

 
• Output Standard: Options are Native, 525i/59.94, 625i/50, 720p/59.94, 1080i/59.94 and 

1080i/50. 
 

• Output Video Colour: Options are Black or Blue, this is the colour that will be output when the 
input is lost.  
 

 

NOTE: Using Blue is a good compliment to the Evertz MVP/VIP systems, which by 
default, use Green to signify loss of the input. Thus a blue screen will indicate a 
loss of source at the encoder, not at the MVP/VIP. 

 
• CC608 Embed: This allows the user to decide if Closed Caption 608 should be embedded on 

the output, by default this is disabled. 
 

• CC608 Embed Line Number: This allows the user to select the line at which the closed 
captions will be embedded; the range is line 7 to 21. 

 
• CC708 Embed: This allows the user to decide if Closed Caption 708 should be embedded on 

the output, by default this is disabled. 
 

• CC708 Embed Line Number: This allows the user to select the line at which the closed 
captions will be embedded; the range is line 7 to 21. 
 

 

1What are "native 608" closed captions? 
CEA-608 ("native 608") closed captions are captions formatted and presented in the 
current analog television system and carried on the two fields of line 21 of the vertical 
blanking interval. Field one contains CC1, CC2, T1, and T2 (the latter being text services). 
Field 2 contains CC3, CC4, T3, and T4. CC1 is most often used to carry verbatim English 
captions and CC3 is increasingly being used for Spanish-language captions and captions 
edited for young children ("Easy Reader" or "Beginning Reader" captions). The common 
look and feel of native 608 captions is limited to white block letters within a box-like black 
background field. Colour (non-white) characters, while possible, are only occasionally 
used due to the 13-year legacy of set-top decoders, which cannot display coloured 
captions. 
 
1What are "native 708" closed captions? 
CEA-708B is the standard for conveying caption data in a digital television signal. 
Because the DTV signal does not have a vertical blanking interval, CEA-708B specifies 
that the captioning data shall be carried in the video user bits of the MPEG-2 bitstream. 
CEA-708B captions have greatly enhanced formatting and display capabilities compared 
to NTSC 608 captions. Strictly speaking, native 708 captions are those authored and 
encoded for CEA-708B use. It is also possible to encode native 708 format captioning 
from authoring information intended for 608 captioning, although such captions will have 
the same limitations as translated captions. 
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3.5. GENERAL 

This tab is for information only; it displays the type of card that is installed in the chassis.  The card also 
has the ability to monitor the power supplies of the frame in which it resides in.  Simply check the 
Frame Status Error box to enable SNMP traps.  The Frame Trap Status LED is an indicator that will 
turn red when one or both of the frame’s power supplies fail.    
 

 
Figure 3-6 VistaLINK® PRO - General 
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3.6. MISC FAULTS 

 
Figure 3-7 VistaLINK® PRO – Misc Faults 

 

3.6.1. Trap Status 

• Video Output: The status of the video output trap is shown in this field; when video is being 
output the LED will be green. 

 
• Closed Caption Presence: The status of the video output trap is shown in this field; when 

Closed Caption video is being output the LED will be green. 
 

3.6.2. Trap Enable 

• Video Output: The Video Output trap in the output trap can be enabled / disabled in this field. 
 

• Closed Caption Presence: The Closed Caption embedding in the output trap can be enabled / 
disabled here. 
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4. CONFIGURING INPUTS 

4.1. INPUT MONITOR 

 
Figure 4-1 VistaLINK® PRO – Input Monitor 

 

4.1.1. Input Monitor 

• Input State: Displays either Active or Inactive, this field displays the state of the current input 
(either input 1 or input 2). 

 
• Num Programs: This indicates the number of programs present within the stream; this is read 

from the PSIP / PSI in the stream. 
 

• Input Bitrate: This indicates the gross bitrate of the input in bits/s. 
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• Network ID: This indicates, in decimals, the Network ID.  This is read from the PSIP / PSI in the 
stream. 

 
• Network Name: This indicates the Network Name of the stream, if present.  This is read from 

the PSIP / PSI in the stream. 
 

4.1.2. Input Control 

• Input Stream Mode: Options available are ATSC, DVB and MPEG.  
o It is important to select the standard to which the stream is being coded as this affects 

the context of the alarms for ETSI TR 101 290 priority 3 and the handling of AC3 Audio. 
 

• PID Display Mode: Options are Hex or Decimal.  This determines how the PID Monitor View 
displays the PID value. 

 
• Clear All Stats: Select enable, and then apply the change. All statistics will be reset. 

 
• Clear All Errors: Select enable, and then apply the change. All error conditions will be reset. 
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4.2. TS SYNTAX ERRORS – P1 & P2 

This tab displays a general health check of the most important elements of the TS. The tests are not 
exhaustive and are outlined, in detail, in the document Digital Video Broadcasting (DVB); Measurement 
guidelines for DVB systems ETSI TR 101 290.  
 

 
Figure 4-2 VistaLINK® PRO - TS Syntax Errors P1 & P2 

 
For each test there is a Fault Monitor check box. Selecting this check box will update the Input 
Configuration Tab - Syntax Error status and enable the alarm. The highest alarm severity will prevail. 
When selecting the check box be sure to select, from the drop down box, the corresponding severity 
that should be associated with this alarm. 
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4.2.1. P1 Necessary for Decoding 

• TS_sync_loss:  The most important function for the evaluation of data from the MPEG-2 TS is 
the sync acquisition. The actual synchronization of the TS depends on the number of correct 
sync bytes necessary for the device to synchronize; two or more consecutive corrupted sync 
bytes indicate sync loss. After synchronization has been achieved the evaluation of the other 
parameters is carried out. 

 
• Sync_byte_error:  The indicator "Sync_byte_error" is set as soon as the correct sync byte 

(0x47) does not appear after 188 or 204 bytes. This is fundamental because this structure is 
used throughout the channel encoder and decoder chains for synchronization. It is also 
important that every sync byte is checked for correctness since encoders do not necessarily 
check the sync byte.   

 
• PAT_error: The Program Association Table (PAT), which only appears in PID 0x0000 packets, 

tells the decoder what programs are in the TS and points to the Program Map Tables (PMT) 
which in turn point to the component video, audio and data streams that make up the program. 
If the PAT is missing then the decoder can do nothing, no program is decodable. Nothing other 
than a PAT should be contained in a PID 0x0000. 

 
• Continuity_count_error:  For this indicator three checks are combined. The preconditions 

"Incorrect packet order" and "Lost packet" could cause problems for receivers that are not 
equipped with additional buffer storage and intelligence. It is not necessary for the test 
equipment to distinguish between these two preconditions as they are logically OR-ed, together 
with the third precondition, "a packet occurs more than twice" into one indicator.  

 
• PMT_error: The Program Association Table (PAT) tells the decoder how many programs there 

are in the stream and points to the PMTs that contain the information where the parts for any 
given event can be found. Parts in this context are the video stream (normally one), the audio 
streams and the data stream (e.g. Teletext). Without a PMT the corresponding program is not 
decodable. 

 
• PID_error:  It is checked whether there exists a data stream for each PID that occurs. This error 

often occurs where TS are multiplexed, or demultiplexed and again remultiplexed.  
 

4.2.2. P2 Recommended 

• Transport_error:  The primary Transport_error indicator is Boolean which counts the erroneous 
TS packets. This counter is intended for statistical evaluation of the errors. If an error occurs, no 
further error indication should be derived from the erroneous packet.  

 
• CRC_error:  The CRC check for the CAT, PAT, PMT, NIT, EIT, BAT, SDT and TOT indicates 

whether the content of the corresponding table is corrupted. In this case no further error 
indication should be derived from the content of the corresponding table. 

 
• PCR_error:  The PCRs are used to re-generate the local 27 MHz system clock. If the PCR 

does not arrive with sufficient regularity then this clock may jitter or drift. The PCR discontinuity 
of more than 100 ms occurring without specific indication or the time interval between two 
consecutive PCR values is more than 40 ms. 
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• PCR_repetition_error: The PCRs are used to re-generate the local 27 MHz system clock. If 
the PCR do not arrive with sufficient regularity then this clock may jitter or drift. The 
receiver/decoder may even go out of lock. This error indicates that the time interval between two 
consecutive PCR values is more than 40 ms. 

 
• PCR_discontinuity_indicator_error: The PCR_discontinuity_indicator_error is set in the case 

that a discontinuity of the PCR values occurs that has not been signalled appropriately by the 
discontinuity indicator.  

 
• PCR_accuracy_error: The accuracy of ±500 ns is intended to be sufficient for the colour sub-

carrier to be synthesized from the system clock. This test should only be performed on a 
constant bitrate TS as defined in ISO/IEC 13818-1. 

 
• PTS_error: The Presentation Time Stamps (PTS) should occur at least every 700 ms. The PTS 

is only accessible if the TS is not scrambled. 
 
• CAT_error:  The CAT is the pointer to enable the receiver to find the EMMs associated with the 

CA system(s) that it uses. If the CAT is not present, the receiver is not able to receive 
management messages. 
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4.3. TS SYNTAX ERRORS – P3 

 
Figure 4-3: VistaLINK® PRO – TS Syntax Errors P3 

 

4.3.1. P3 DVB Tables 

• NIT_Repetition_error: This test checks that any two sections with table_id = 0x40 (NIT_actual) 
occur on PID 0x0010 within a 25 ms. 

 
• NIT_error: Network Information Tables (NITs) as defined by DVB contain information on 

frequency, code rates, modulation, and polarization etc. of various programs that the decoder 
can use. It is checked whether NITs are present in the TS and whether they have the correct 
PID. The test checks that sections with table_id 0x40 or 0x41 in PID value 0x0010 occur at least 
every 10 s. 
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• Unreferenced_PID: Each non-private program data stream should have its PID listed in the 
PMTs. This test detects the presence of a PID (other than PAT, CAT, CAT_PIDs, PMT_PIDs, 
NIT_PID, SDT_PID, TDT_PID, EIT_PID, RST_PID, reserved_for_future_use PIDs, or PIDs user 
defined as private data streams) not referred to by a PMT within 0.5 s 

 
• SI_repetition_error: For SI tables a maximum and minimum periodicity are specified in EN 300 

468 [7] and TR 101 211 [8]. This indicator should be set in addition to other indicators of 
repetition errors for specific tables. 

 
• SDT_error:  The SDT describes the services available to the viewer. It is split into sub-tables 

containing details of the contents of the current TS (mandatory) and other TS (optional). Without 
the SDT, the IRD is unable to give the viewer a list of what services are available. It is also 
possible to transmit a BAT on the same PID, which groups services into "bouquets". 

 
• SDT_Repetition_error: This test checks that the SDT information which describes the services 

contained in a particular Transport Stream is transmitted at least every 2 seconds on PID 
0x0011. 

 
• EIT_error:  The EIT (Event Information Table) describes what is on now and next on each 

service, and optionally details the complete programming schedule. The EIT is divided into 
several sub-tables, with only the "present and following" information for the current TS being 
mandatory. The EIT schedule information is only accessible if the TS is not scrambled. 

 
• RST_Repetition_error:  This test checks that any two sections with table_id = 0x71 (RST) 

occur on PID 0x0013 within 25 ms (or lower). 
 

• RST_error: The RST is a quick updating mechanism for the status information carried in the 
EIT. 

 
• TDT_Repetition_error: This test checks that any two sections with table_id = 0x70 (TDT) occur 

on PID 0x0014 within 25 ms. 
 

• TDT_error: Sections with table_id = 0x70 (TDT) not present on PID 0x0014 for more than 30 s. 
The TDT carries the current UTC time and date information.  

 
More information can be found at: http://www.etsi.org/ 
 

4.3.2. P3 ATSC Tables 

• MGT Repetition: Master Guide Table. For each type of PSIP tables, the MGT provides the 
location in the Transport stream, the current version of the table and the length in bytes. This 
test checks that the Master Guide Table repetition rates do not exceed 150ms. 

 
• TVCT Repetition: Terrestrial Virtual Channel Table. Consists of virtual channel definitions 

where each channel is characterized by the two-part channel number that the user will use to 
access the service, its text name, how the service is physically delivered, its MPEG-2 
program_number, its “source ID” and the type of service. This test checks that the Terrestrial 
Virtual Channel Table repetition rates do not exceed 400ms. 
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• CVCT Repetition: Cable Virtual Channel Table. Consists of virtual channel definitions where 
each channel is characterized by the two-part channel number that the user will use to access 
the service, its text name, how the service is physically delivered, its MPEG-2 program_number, 
its “source ID” and the type of service. This test checks that the Cable Virtual Channel Table 
repetition rates do not exceed 400ms. 

 
• EIT Repetition: The PSIP table that carries program schedule information for each virtual 

channel, this test checks the following is true: 
o EIT-0 Once every 0.5 seconds 
o EIT-1 Once every three seconds 
o EIT-2 and EIT-3 Once every minute 

 
• RRT Repetition: Rating Region Table. Defines a rating system for a given region characterized 

by a number of rating dimensions, each of which is composed of two or more rating levels. This 
test checks that the Rating Region Table repetition rates do not exceed 60,000ms. 

 
• STT Repetition: System Time Table. Provides a reference for the time-of-day to receivers. This 

test checks that the System Time Table repetition rates do not exceed 1000ms  
 
More information can be found at: http://www.atsc.org 
 

4.3.3. ETSI TR 101 290 Test Conditions 
The status LED located to the left of each test will highlight, when in Auto-Refresh, the dynamic status 
of the stream. 
 
For the majority of the ETSI TR 101 290 test it is possible to configure custom configurations to ensure 
that particular alarms and conditions are fed back to the operator. It is important to select the Monitor 
Enable check box (to enable custom monitoring parameters to be invoked), select the desired alarm 
Severity and then configure the test Threshold.  
 

 
NOTE: Syntax Errors P1, P2 & P3 are measured in ms. PCR Errors are measured 
in ns. 
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4.4. TR 101 290 DVB REFERENCE VALUES 

Test DVB  
TS_sync_loss   
Sync_byte_error   
PAT_error 500ms  
Continuity_count_error   
PMT_error 500ms  
PID_error 500ms  
Transport_error   
CRC_error   
PCR_repetition_error 40ms  
PCR_error 500ns  
PTS_error 700ms  
CAT_error   

Table 4-1: TR101 290 DVB Reference Values 
 

4.5. PID MONITOR (+MON OPTION) 

The PID Monitor tab is where VLPro displays the standard Transport Stream parameters. As shown in 
Figure 4-4, it is possible to see all the packets within the TS stream. They are organized in ascending 
order by Service ID but can also be re-ordered by Prog #. This can be done by double clicking the 
column header, make sure you are not in the auto refresh mode when doing this. 
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Figure 4-4 VistaLINK® PRO – PID Monitor 

 
For each individual PID it is possible to view the minimum and maximum Bitrate since the last reset 
(Clear Stats Reset). The columns Min and Max Thresholds can be user configured to provide a 
triggered alarm for under or over bitrate conditions per PID, by default these are set to 0 and 100Mb/s 
respectively.  

 

 
Note: The PID Monitor is a dynamic view; by clicking the auto refresh button it is 
possible to see near instantaneous values for the stream. 
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4.6. TEMPLATE CHECK 

The template tab offers full customization of the alarms to individual PIDs, and the overall ASI stream. 
This tab is divided into 4 different sections for Global Control, Misc Template, Window 
Measurements and PID List Template all of which will be described in sections 4.6.1 to 4.6.3. 
 

 
Figure 4-5: Template Check 

4.6.1. Global Control 

• Min Bitrate:  Enter the minimum transport stream bitrate (bps).   If this value is exceeded then a 
trap will be sent. Be sure to allow some overhead for natural stream variance.  

 
• Max Bitrate: Enter the maximum transport stream bitrate (bps).  If this value is exceeded then a 

trap will be sent.  Be sure to allow some overhead for natural stream variance.  
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4.6.2. Misc. Template 

• TS ID Expected:  Enter the value for the Transport Stream ID expected, enter zero to disable 
the test. A trap will be sent if the card receives a stream with a different value. 

 

 
Note:  It is not possible to enter the TS ID as a Hex value. 

 
Num PIDs Expected:  Enter here the number of PIDs expected in the stream, enter zero to disable the 
test. A trap will be sent if the number of PIDs within the stream increases or decreases. 
 

4.6.3. Window Measurement 
The window measurement values determine the interval at which each PID (within the PID List 
Template) should be expected before an alarm condition is met.   
 

o Window Measurement 1 (ms):  Enter a decimal value, measurement is in milliseconds  
o Window Measurement 2 (ms):  Enter a decimal value, measurement is in milliseconds 
o Window Measurement 3 (s):  Enter a decimal value, measurement is in seconds 

 
• PID List Template: The PID List Template provides a stream conformance or validation check 

with the capability of alarming based on the status of each individual PID in the stream.  Here 
we can check the presence of each PID using one of the Window measurements as a detailed 
above.  Depending upon the importance of the PID we can selectively send an alarm if a PID is 
missing beyond the measurement window selected.  

 
• Snapshot Live Stream: This button is used to populate the PID List Window with the PIDs 

currently found in the stream.  Use of this button is slightly different from most normal operations 
within VLPro.  

o Simply click the Snapshot Live Stream button and then the Refresh Configuration View 
button; the Snapshot button is automatically applied.   

o On an operational system ensure you de-select the PID List Template check box before 
making a new snapshot, this will avoid alarm conditions being raised as the PID list 
changes. 

 
• PID List Template:  Once the PID List template has been populated and fully configured, this 

check box must be checked to activate the PID List checking.   
 

• Reset PID Template:  This button can be used to reset the PID List.  All entries will be set to 
“NOT SET”, all Windows Measurements (WM) set to “Off” and the Switch Method will also be 
set to “Off”.  This is useful when changing the switch from one stream to another stream and the 
setting will be completely different.  Make sure the PID List Template check box is not checked 
before resetting to avoid unexpected switching.  
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4.7. FAULT CONTROL 

The fault control tab is a user configurable tab for enabling or disabling the fault conditions that can be 
triggered by the standard ETSI TR 101 290 checks discussed in the previous chapter. 
 

 
Figure 4-6 VistaLINK® PRO Fault Monitor 

 
The four window sub-sections allows users to custom configure which ETSI TR 101 290 test conditions 
can trigger an alarm: 
 
Within this tab it is possible to individually de-select (all are selected by default) or later re-select which 
tests can produce an alarm condition. The following subsections correspond with the previous Syntax 
Error tabs: 

• P1 Necessary for Decoding 
• P2 Recommended 
• P3 DVB Tables 
• P3 ATSC Tables 
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It is important to ensure new settings are applied using the apply button on the menu. 
 

 

Note: DVB/ATSC P3 tests may be greyed out depending on which mode has been 
selected under the Input Monitor Tab (DVB/ATSC or MPEG). ATSC mode will disable 
DVB; DVB mode will disable ATSC and MPEG will disable both ATSC and DVB. 

 

4.8. TRIGGER FAULTS 

This tab is divided into two window subsections: 
 

• Trigger Fault Enable: Allows the user to customize the top-level alarms.  
 

• Trigger Fault Status:  This section is used as a visual status indicator. 
 

 
Figure 4-7: Trigger Faults 
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5. TECHNICAL DESCRIPTION 

5.1. SPECIFICATIONS 

5.1.1. Inputs and Outputs per Switch 

• 2 x ASI Input per DVB TR 101 891-270Mb/s, maximum bitrate 180Mb/s 
• SDI 270Mb/s SMPTE 259M 
• HD SDI 1.485Gb/s SMPTE 292M 

  

5.1.2. Decoding Specifications 
SD Encoding Standard Supported:  MPEG-2 Main Profile @ Main Level 
Video Format:  Standard Definition 525 (NTSC) and 625 (PAL) 
HD Encoding Standard Supported:  MPEG-2 Main Profile @ High Level  
Video Format:  HD 720P and 1080i 60Hz and 50Hz 

Embedding of HANC and VANC 
Audio Pass Through 
Closed Caption 
VITC 
WSS 
Teletext and Subtitle 

 

5.1.3. Embedding of HANC & VANC 

• Audio Pass Through 
• Closed Caption 
• VITC 
• WSS 
• Teletext & Subtitle 

 

5.1.4. Electrical  
Power:  41w 
 

5.1.5. Physical  
Number of Slots:  3 
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6. TROUBLESHOOTING 

6.1. VLPRO DOES NOT DISPLAY THE 7780DEC-MP2HD ALARMS 

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been 
established check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

6.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 6-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 6-2, simply navigate to the location of the new JAR file and 
double click to select the file. The window will automatically close and the update will be applied in the 
background.  
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Figure 6-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
Figure 6-3: “Please Restart Your Alarm Server” Dialog Box 

 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 
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7. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  Band Width 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
GOP Group of Pictures 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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